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CHAPTER 1

Getting Started

Parallels® Client for Windows is an app that allows you to connect to Parallels RAS from a Windows
computer and run remote applications and desktops.

In This Chapter

Parallels RAS 19 release NiSTONY ... ....uuuueuiiiiiiiiiiiiiiiiiiiiiiiiiiieiiieeeeeeeeeeeeseeeennseeeeeneennnes 5
SyStEM REQUIFEMENTS ...t eaaaaes 5
Installing Parallels Client Using an Invitation Email...........ccooooooiiiiiii, 6
Installing Parallels Client Manually ...............iiiiiiiiiiiii e 8

Parallels RAS 19 release history

The following table lists the Parallels RAS 19 release history. Parallels RAS documentation is
updated for every release. This guide refers to the latest Parallels RAS 19 release from the table
below. If you are using a newer Parallels RAS release or version, please download the current
version of the guide from https://www.parallels.com/products/ras/resources/.

Parallels RAS Version Release Date

19.0 Initial release 07/27/2022
19.0 Update 1 08/31/2022
19.0 Hotfix 1 09/16/2022
19.0 Hotfix 2 09/30/2022
19.0 Hotfix 3 10/14/2022
19.1 Update 2 11/15/2022
19.2 Update 3 07/06/2023
19.3 Update 1 11/06/2023

System Requirements

Starting from Parallels Client 19, x86, x64, and ARM64 architectures are natively supported.
Parallels Client for Windows has the following software and hardware requirements:
= Windows 7, 8%, 10, 11


https://www.parallels.com/products/ras/resources/
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< The same hardware requirements as specified by Microsoft for the above versions of Windows.

= Some features (high color graphics, sound, etc.) will only be available if your Windows computer
has the appropriate hardware installed and is properly configured.

Installing Parallels Client Using an Invitation Email

Your Parallels RAS administrator will send you an invitation email with the instructions on how to
install Parallels Client for Windows and configure a Parallels RAS connection. The invitation email will
contain the following information and action links:

= A message from your system administrator.

« Alink to download Parallels Client for Windows (links to Parallels Client for other platforms may
also be included if you are using other devices in addition to a Windows computer).

= Alink to automatically configure Parallels Client on your computer, So you can connect to
Parallels RAS.

= Parallels RAS connection properties. You can use this information to manually create a Parallels
RAS connection. The automatic configuration via the link (see above) is the preferred and the
easiest method, but you can use this information to create a connection manually if needed for
any reason.

Install Parallels Client for Windows
To install Parallels Client for Windows using an invitation email:

1 In the invitation email, click the Windows thumbnail to download Parallels Client for Windows
installer.

2 When the download is complete, go to your download folder and run the file that you just
downloaded.

3 Follow the onscreen instructions to begin the installation.

4 If you don't have administrative permissions on this computer, a dialog will open saying so. The
dialog has two buttons: Install Full Client and Install Basic Client. If you know credentials of
an administrative account on this computer, click Install Full Client and enter the credentials
when asked. The installation will continue using these credentials and the full version of Parallels
Client will be installed. If you don't know the credentials, click Install Basic Client. The basic
version of Parallels Client will still work but some of the functionality will be missing.

5 On the Shortcuts page, select where you want to create a Parallels Client shortcut. You can
select one or more options.

6 The SSO Installation page will be skipped when installing Parallels Client on a Windows Server
operating system. On all other supported versions of Windows, it will be shown. Use the page to
specify whether you want to install the Single Sign-On component. The component will
automatically use your credentials to connect to Parallels RAS. Please note that for the
component to work, you will need to reboot your computer (or log off and then log on again)
after the installation.

Click Next.
On the Ready to Install page, click Install.
Once the installation is complete, click Finish to close the wizard.

o ©O© 00 N
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You now need to configure Parallels Client, so it can connect to Parallels RAS. The invitation email
that you received from your system administrator includes a link that can accomplish this task
automatically. Please follow the instructions below to configure Parallels Client.

Configure Parallels Client for Windows

To configure Parallels Client:

1 In the invitation emalil, find the Configure section and click the Click Here to auto configure
the downloaded client link.

2 The link will open in a web browser after which you should see the following dialog:

This link needs to be cpened with an application.

Send to:

TSClient Application

Choose an Application

[] Remember my choice for tuxclient links.

[ oK ]| Cancel|

3 Make sure the TSClient Application item is selected and click OK. This will configure Parallels
Client for Windows and then will display the Log In screen.

#JLogin-10211.554 X

|| Parallels’

Authentication type: Credentials ~

Username: |

Password:

Save Password

Connect Cancel Options >>

4 Select the Authentication Type from the following:
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= Credentials. Select this option to connect to Parallels RAS by supplying your credentials,
such as your domain user name and password.

= Smart card. Select this option to connect to Parallels RAS using a smart card.

= Single Sign-On. This option will be included in the list only if the Single Sign-On module is
installed during Parallels Client installation. Select this option to use local system credentials
to connect to the remote server.

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in
Connection / Authentication.

5 Depending on the authentication type selected, type your user name and password or insert a

smart card into a reader. If using a smart card, enter a PIN when prompted.

6 Click Connect.

You should now see the main Parallels Client window. The left pane of the window displays the
connection that was automatically configured for you.The right pane displays published resources
that you can use.

R

Favorites

Desktop
Folder

»

Paint

¢

msedge

E Parallels Client

= My RAS Connection

All apps

- All apps » RDSH

RAS

Managemen...

[

Wordpad

\L-) I

wmplayer

AppPackage

>

Computer
Management

Individual
server items

RDSH
Desktop

Event Viewer

Registry Editor

¥ g

Control Panel

B

Task Manager

S—

Keyboard
Properties

Ce

Calculator

notepad

L .

Command
Prompt

Double-click a resource to open it. The resource will open in a separate window on your local
computer as if it was a local application or a document (or a remote desktop if one is available as a
published resource).

Installing Parallels Client Manually

The preferred method of downloading and installing Parallels Client for Windows is via an invitation
email as described in the previous section. If you would like to download and run the installer
manually, visit https://www.parallels.com/products/ras/download/client.
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To install Parallels Client for Windows:

1 Run the Parallels Client installer that you've downloaded from the Parallels website and follow
the onscreen instructions to being the installation.

2 |If you don't have administrative permissions on this computer, a dialog will open saying so. The
dialog has two buttons: Install Full Client and Install Basic Client. If you know credentials of
an administrative account on this computer, click Install Full Client and enter the credentials
when asked. The installation will continue using these credentials and the full version of Parallels
Client will be installed. If you don't know the credentials, click Install Basic Client. The basic
version of Parallels Client will still work but some of the functionality will be missing.

3 On the Shortcuts page, select where you want to create a Parallels Client shortcut. You can
select one or more options.

4 The SSO Installation page will be skipped when installing Parallels Client on a Windows Server
operating system. On all other supported versions of Windows, it will be shown. Use the page to
specify whether you want to install the Single Sign-On component. The component will
automatically use your credentials to connect to Parallels RAS. Please note that for the
component to work, you will need to reboot your computer (or log off and then log on again)
after the installation.

5 Click Next.
On the Ready to Install page, click Install.

7 When the installation is complete, click Finish to close the wizard and start Parallels Client for
Windows.

o

Connecting to Parallels RAS

After you manually install Parallels Client and run it for the first time, you'll be asked if you would like
to configure a new connection. Click Yes. This will open the New connection dialog.

New Connection ? b

|| Parallels’

Access your apps and desktops by providing your work email or server address.

Create RDP Connection instead Next Cancel

Your system administrator should give you the connection information that must be specified in this
dialog. If you received an invitation email from your administrator, you can find this information at the
bottom of the message. The information will look similar to the following:
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To manually configure the RAS Connection, use the following settings:

Server: 192.168.1.10
Port: 443
Connection Mode: Gateway SSL Mode

To connect to Parallels RAS:

1

10

Enter the Parallels RAS IP address, its hostname (this should be the server where the RAS
Secure Gateway resides), or your work email address. You system administrator should tell you
what to use.

Click Next.

In the Connection mode field, select one of the following options (note that you should use the
mode that your system administrator has asked you to use):

Direct Mode. Parallels Client first connects to the RAS Secure Gateway for the best available
terminal server and then connects directly to that server. This is best used when the
Parallels Client and the terminal server reside on the same network.

Direct SSL Mode. Same as the direct mode above, but uses encryption to secure the data.

Gateway Mode. Parallels Client connects to the RAS Secure Gateway and the session
connection is tunneled through the first available connection. This mode is ideal for servers
that are only reachable via the gateway and do not require a high level of security.

Gateway SSL Mode. Same as the gateway mode above, but uses encryption to secure the
data.

In the Friendly name field, choose and type a friendly name for this connection.
If your system administrator instructed you to specify the port number, do the following:

a

c

Click the Advanced settings link. The Connection Properties dialog opens (see the
screenshot below).

Specify the port number in the Port field.

You can also review and modify other properties if you wish. More on these later in this
guide.
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d The [...] button next to the Primary Connection field allows you to select a Parallels RAS

server (this will only work if the Broadcast RAS Secure Gateway Address option has been
enabled on the server side).

Connection Properties - My RAS Connection ? X
Experience Network Server authentication Advanced settings
Connection Display Printing Scanning Local resources

Connection settings

; Primary connection:

Connection mode:

Port:

Name:

Login

g (] Auto login
Authentication type:

Username:

Password:

Domain:

Gateway SSL Mode v

443

Secondary connections...

My RAS Connection

Credentials ~

Save password

'o' This connection is FIPS compliant.

oK Cancel Help

11
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6

10

12

Click OK. The Log in dialog opens.

#JLog in-10.211.554 X

|| Parallels’

Authentication type: Credentials i

Username: |

Password:

Save Password

Connect Cancel Options >>

In the Authentication type drop-down list, select the desired method of authentication:

= Credentials. Select this option and then enter your username and password. You will be
authenticated on the remote server using the specified credentials.

< Smart Card. Select this option to authenticate using a smart card. When connecting to the
remote server, insert a smart card into the card reader and then enter a PIN when prompted.

= Single Sign-On. This option will be included in the list only if the Single Sign-On module is
installed during Parallels Client installation. Select this option to use local systemedentials to
connect to the remote server

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in
Connection > Authentication.

Click Connect.

This step may, or may not, appear depending on whether the two-factor authentication using
the Google Authenticator app is configured in Parallels RAS by the administrator. If Parallels RAS
is configured to use Google Authenticator, you will need to take additional steps. First you need
to install the Google Authenticator app on your mobile device. When you click Connect in
Parallels Client, you'll see a dialog displaying a barcode (also known as QR code) and a secret
key. Scan the code (or enter the secret key) into the Authenticator app. The app will generate a
one time password. Click Next in Parallels Client and enter the one time password in the OTP
field. Click Connect. On every subsequent logon, you'll only have to enter the OTP. For
step-by-step instructions, see the Using Google Authenticator subsection below.

If the connection is successful, you'll see the main Parallels Client window where your
connection(s) and published resources are displayed.
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[ ﬁ Parallels Client - m] x
= My RAS Connection

Favorites All apps N~ g

‘ - All apps > RDSH

2 B B A & B - &

Desktop AppPackage RDSH Region Control Panel Keyboard notepad
Folder Managemen... Desktop Properties
» R 1 :; ) e —
oF = ! i 1] " @
L 1 37 o ; | £
Paint Wordpad Computer Event Viewer Registry Editor Task Manager Calculator Command
Management Prompt
| Gl =
msedge wmplayer Individual

server items

Using Google Authenticator

Use the following instructions when you see the multi-factor authentication dialog during the login
procedure. The dialog is displayed when your IT administrator configures two-factor authentication
using the Google Authenticator app.

Important: To use Google Authenticator, the time on your computer must be synchronized with a global
NTP time server, such as time.google.com. Otherwise, Google authentication will fail.

To use Google Authenticator, you need to install the Authenticator app on your iOS or Android
device. Simply visit Google Play or App Store and install the app. Once the Authenticator app is
installed, you are ready to connect to Parallels RAS using two-factor authentication.

To connect to Parallels RAS:

1 Opens Parallels Client and log in using your credentials.

2 The multi-factor authentication dialog opens displaying a barcode (also known as QR code) and
a secret key.

3 Open the Google Authenticator app on your mobile device:
= [f this is the first time you use it, tap Begin and then tap Scan a barcode.
= [f you already have another account in Google Authenticator, tap the plus-sign icon and

choose Scan a barcode.

4 (o back to your computer and scan the barcode displayed in the Parallels Client login dialog.
If scanning doesn't work for any reason, go back in the Authenticator app, choose Enter a
provided key and then enter the account name and the key displayed in the Parallels Client
login dialog.
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5 Tap Add account. This will create an account for your RAS connection and display a one time
password.

6 Go back to Parallels Client, click Next and enter the one time password in the OTP field.

On every subsequent logon, you only need to type your credentials (or nothing at all if the Save
password options was selected) and enter a one time password obtained from the Google
Authenticator app (the app will continually generate a new password). Please note that your IT
administrator has an ability to reset user accounts in Google Authenticator. If your account is reset,
you'll need to repeat the registration procedure described above.

Advanced Parallels Client Installation

Note: This section is intended for IT Administrators. If you are not an IT administrator in your organization,
you may skip it.

The Parallels Client for Windows installer uses the MSI format. This enables you to deploy it remotely
using Group Policies or any other deployment tool that can work with MSI installers.
There are two ways to modify the client installation settings:

= Modify the original file using Orca.exe.

< Run the installer from the command line: msiexec.exe /i RASClient.msi (or
RASClient-x64._msi if using a 64 bit version)

Silent Install
To perform a silent install, run the following command:

msiexec.exe /qn /i RASClient.msi

In the command above, specify RASClient-x64._msi if using a 64 bit version of Parallels Client
for Windows.

General Settings

When running an installation command specified above, you can pass the following properties to
msiexec.exe using the PROPERTY=VALUE notation:

DEFSETTINGS: To use when Parallels Client installer reads 2xsetting.2xc (the file containing all
settings to be used by the client) as default settings.

DEFSETTXML: To use when XML settings are entered manually.
OVERRIDEUSERSETTINGS: To override the user settings with client MSI settings.

= (- Client settings are not overridden
1 -Client settings are overridden with the new settings of the Client MSI setup.

DISABLEOPTIONS: To disable the Options button and hide the options to configure the client
settings. This option can be applied to users without administrative rights.

e (0 - Options are enabled
e 1 - Options are disabled

14
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DISABLEOPTIONSADMIN: To disable the Options button and hide the options to configure the
client settings. This option can be applied to users with administrative rights.

DISABLESAVEPASSWORDADMIN: To disable the clients from saving the password even if they
have administrative rights.

« (0 - Option to save password is enabled

e 1 —Option to save Password is disabled

DISABLESAVEPASSWORD: To disable the clients from saving the password. This option is
ignored with users with administrative rights.

e (O - Option to save password is enabled

= 1 - Option to save Password is disabled

INSTALLSSO: Exclude/Include SSO during silent installation.

e 1 -Install SSO. ADDLOCAL=F_SSO is also required, as in ADDLOCAL=F_SSO INSTALLSSO=1
e 0 - Exclude SSO

IGNORESETTCREDS: Controls the usage of credentials that are available in the .2xc file (available
since builds 16.2.4.19490 and 16.5.1).

= 0 - Connections imported from a .2xc file will use the credentials that are stored in the .2xc file (if
any).
e 1 - Credentials in the .2xc file are ignored (this is the default).

The IGNORESETTCREDS option above allows you to automatically add preconfigured RAS
connection settings when you install Parallels Client. To do so:

1 First install Parallels Client on some computer and configure the desired connection(s). Set a
password for the connections and select Save Password.
2 Export the client settings to a file.

3 When performing a clean Parallels Client installation on a user's computer, use the following
command line parameters:
DEFSETTINGS=<2xc Ffile> IGNORESETTCREDS=0

where <2xc file> is the name of file that you exported in step 2.

4 After the installation, the imported connection settings become available in Parallels Client for all
users of a given computer.

SHAREDDEVICE: Creates a shared RAS connection for all users on a device. To use this
command, you must have administrative privileges.

The command has the following format:
msiexec.exe /qn /i RASClient.msi SHAREDDEVICE="mode:settingsstring"
In the command above, the mode option can have the following values:

= 0 - Deletes the shared connection. When this value is used, settingsstring must be empty,
asin ""0:".

« 1 - Creates a shared connection. In this mode, an IT administrator configures the authentication
type for the connection, and users authenticate using the selected type.

15
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e 2 - Creates a shared connection with shared credentials. In this mode, an [T administrator
configures the credentials for the connection, and users authenticate automatically without
providing them.

The settingsstring option can have the following values:

= Ui - Brings up the Ul to enter the shared connection properties.

e import - Imports shared connection properties from a .xml file created with the "export"
command (below). Format: "1 : import:c:\my data\my file._xml".

= export - Exports share connection properties so that can be imported on another device with the
"import" command (above). Format: ""1:export:c:\my data\my File.xml".

Using Active Directory

There are two different ways that you can deploy an application through Active Directory. You can
either publish the application or you can assign the application.

You can publish applications to users only, but you can assign applications to either users or
computers. The applications are deployed in different ways, depending on which method you
decide to use.

Parallels recommends that administrators assign the applications to COMPUTERS. The main
reason is that the application is actually installed the next time the computer reboots.

When assigning to users, the application is not installed until the user actually clicks on the icons
created for the application.

To assign an application to certain computers, simply do the following in Active Directory:

1 Open the Group Policy Editor.

2 To assign an application to a computer, navigate through the group policy console to Computer
Configuration / Software Settings / Software Installation. Right-click the Software Installation
container and click New > Package in the context menu. Select the appropriate MSI file and
click Open. You are now asked whether you want to publish or assign the application. Select
Assign and click OK.

Please note that when doing a silent installation, the MSI can be deployed using the following syntax
(for the 64 bit version, use RASClient-x64.msi):

msiexec /gn /i RASClient._msi

Example

The following example installs Parallels Client using the DISABLESAVEPASSWORD=0 option
(enable the ability to save the password):

msiexec /qgn /i 2XClient.msi DISABLESAVEPASSWORD=0

16



CHAPTER 2

Parallels Client Overview

Starting with Parallels RAS 19.3.1, Parallels Client for Windows allows you to choose between

modern and classic user interface:

Modern interface streamlines the experience and makes it easier to access all your RAS

resources in one place. In this guide, all actions are specific to modern interface unless stated

otherwise.

Classic interface brings the familiar Parallels Client layout of Parallels Client 19.3 and earlier.

You can switch between modern and classic interface in global options (p. 55).

Modern interface

ﬁ Parallels Client = 0
= My RAS Connection

Favorites Al apps T~ 88~ =

&« All apps > RDSH

E 8 #F B % F = I

Desktop AppPackage RDSH Region Control Panel Keyboard notepad
Folder Managemen... Desktop Properties
3 e m ! — » =

2 | = A 2 ] " [ PN __

4 1 ﬂa L | e i

Paint Wordpad Computer Event Viewer Registry Editor Task Manager Calculator Command

Management Prompt

é
msedge wmplayer Individual

server items

Modern interface is divided into the following sections (from left to right, top to bottom):

Navigation button. Allows to switch between different RAS and RDP connections.
Main menu (p. 37). Allows to perform popular actions with RAS and RDP connections.

Favorite and All apps (p. 37) tabs. Contain published applications and desktops you can
connect to.

Sort button. Allows to sort published resources in different ways.



Parallels Client Overview

= View button. Allows to switche between list and table view for published resources.
< Manage connection menu (p. 37). Allows to perform actions specific for the selected RAS

connection.

= Search button. Allows to search for specific resources.
= Resource navigation and breadcrumbs. Allows to quickly navigate between published folders.

« Resource area. Shows published resources.

Classic interface

10 items

5 Parallels Client - My RAS Connection — O >
File Applications Sessions  Tools  View Help
{— —} ‘T‘ | Connections » My RAS Connection |e H Search
~ B connections Info
~ I My RAS Connection &l u_f' F @
Toals 4 — @
Tools Calculator Paint Wordpad Access 2013
7 % % 9
Excel 2013 Outook 2013 PowerPoint  Word 2013 Skype
2013

Classic interface is divided into the following sections (from left to right, top to bottom):

= Main menu. Allows to perform all actions on RAS and RDP connections and resources.
= Resource navigation and breadcrumbs. Allows to quickly navigate between published folders.

= Search bar. Allows to search for specific resources.

= (Connections tree. Allows to navigate between connections and published folders.

= Resource area. Shows published resources.

18



CHAPTER 3

Using Parallels Client for Windows

Read this chapter to learn how to set up Parallels RAS connections, configure preferences, and use

Parallels Client to launch remote applications and desktops.

In This Chapter

AddiNg @ NEW CONNECHION ...t 19
Configuring @ RAS CONNECHON ...t 20
UsiNg @ RAS CONNECHION ...covviiiii e 37
Configuring an BDP CONNECTION ........uvviiiiii e 44
Using an BDP CONNECTION ......uvuiiiiiccccc e 54
Configure Global OPLIONS. ......uiiiiiiiiii e 55
Exporting and Importing Parallels Client Settings........ccvvvviviiiiiiiie 58
Parallels Client Command Line Parameters .............uuueuriiiriiiiiiiiiiiiiiiiiinnns 59

Adding a New Connection

Parallels Client for Windows allows you to have more than one connection, so you could easily
connect to different servers or using different connection properties.

To add a connection:

1 Open Parallels Client by clicking Start > All Apps > Parallels > Parallels Client (or double-click

the Parallels Client icon on your desktop).

2 In the main Parallels Client window, click the Navigation button and select New connection
(File > New Connection in classic interface). The New connection dialog opens.

3 Do one of the following:

= |If you want to create a Parallels RAS connection, enter the Parallels RAS IP address, its
hostname (this should be the server where the RAS Secure Gateway resides), or your work
email address.

Note: Connection discovery by email needs to be configured by system administrators. Contact
your system administrator to make sure that this option is enabled.

= |f you want to create an RDP connection, click the Create RDP Connection instead link.
4 Click Next.
5 On the next dialog, specify the server address.
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When creating a Parallels RAS connection, your system administrator should give you the
connection information that must be specified in this dialog. If you received an invitation emalil
from your administrator, you can find this information at the bottom of the message. The
information will look similar to the following:

To manually configure the RAS Connection, use the following settings:

Server: 192.168.1.10
Port: 443
Connection Mode: Gateway SSL Mode

When creating a Standard RDP connection, you need to know the IP address or hostname of
the remote computer you want to connect to.

6 If creating a Standard RDP connection, specify the remote computer IP address or hostname in
the Server field. If you are creating a Parallels RAS connection, this field will be auto-populated.

7 The Connection mode drop-down list is enabled only when creating a Parallels RAS
connection. Select one of the following options (note that you should use the mode that your
system administrator has asked you to use):

= Direct Mode. Parallels Client first connects to the RAS Secure Gateway for the best available
terminal server and then connects directly to that server. This is best used when the
Parallels Client and the terminal server reside on the same network.

= Direct SSL Mode. Same as the direct mode above, but uses encryption to secure the data.

< Gateway Mode. Parallels Client connects to the RAS Secure Gateway and the session
connection is tunneled through the first available connection. This mode is ideal for servers
that are only reachable via the gateway and do not require a high level of security.

= Gateway SSL Mode. Same as the gateway mode above, but uses encryption to secure the
data.

8 In the Friendly name field, choose and type a friendly name for this connection.

9 The Advanced settings link opens the Connection Properties dialog where you can specify
additional connection properties. For more information, please see Configuring a RAS
Connection or Configuring an RDP Connection.

10 Click OK to create a connection and connect to Parallels RAS.

Configuring a RAS Connection

To view and modify the properties of an existing Parallels RAS connection, click the Navigation
button, right-click the connection and then click Connection Properties in the context menu
(right-click the connection in the main Parallels Client window and then click Connection
Properties in the context menu in classic interface). This will open the Connection Properties
dialog. Properties are grouped in the dialog by functionality using tab pages. The following
subsections describe each tab page in detalil.

Connection
Display
Printing
Scanning
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= Local resources
= Experience
= Network
= Server authentication
= Advanced settings
Note: If you are an IT administrator, you can automatically add one or more preconfigured connections to

Parallels Client during installation. For details, see the description of the IGNORESETTCREDS option in the
Advanced Parallels Client Installation section (p. 14).

Connection

The Connection tab page allows you to specify connection properties and login information.

Connection Properties - My RAS Connection ? X
Experience Network Server authentication Advanced settings
Connection Display Printing Scanning Local resources

Connection settings

Primary connection:

Connection mode: Gateway SSL Mode v

Port: 443

Secondary connections...

Name: My RAS Connection
Log in
(] Auto login
3 Authentication type: Credentials ~
Username:
Password:

Save password

Domain:

'o' This connection is FIPS compliant.

OK Cancel Help
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Configuring the Primary Connection

On the Connection tab page, configure the primary connection and one or more secondary
connections.

The primary connection is what Parallels Client will use first to connect to the specified server. This
should be the server where the primary RAS Secure Gateway is running.

To specify the primary connection information:

1

4

In the Primary connection field, specify the server name or IP address. To connect to a specific
RAS Theme, specify its name after the server name or IP address separated by a slash. For
example, workspaceus.parallelsras.net/theme1. If not sure which Theme you should use, ask
your system administrator.

You can click the [...] button and select a server from the list. If the server is not listed, it means
that the system administrator disabled this functionality on the server side. In such a case,
specify the server by typing its name or IP address in the Primary Connection field.

Note for Administrators: The Broadcast RAS Secure Gateway Address option must be enabled
on the server side for the [...] button to display the server.

In the Connection mode drop-down list, select one of the following options:

« Gateway Mode: Parallels Client connects to the RAS Secure Gateway and the session
connection is tunneled through the first available connection. This mode is ideal for servers
which are only reachable via the gateway and do not require a high level of security.

= Gateway SSL Mode: Same as the gateway mode above, but uses encryption to secure the
data.

= Direct Mode: Parallels Client first connects to the RAS Secure Gateway for the best available
terminal server and then connects directly to that particular server. This is best used when
the Parallels Client and the terminal server are on the same network.

= Direct SSL Mode: Same as the direct mode above, but uses encryption to secure the data.

In the Port field, specify the port on which the gateway listens for incoming connections. If the
default value has been modified on the server side, you have to replace the default value here as
well. Otherwise, leave the default value intact.

In the Friendly Name field, choose and type a nhame of your choice.

Configuring a Secondary Connection

If the server you are connecting to has more than one RAS Secure Gateway, you can define a
secondary connection, which will be used as a backup connection in case the primary connection
fails.

To add a secondary connection:

1
2
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Click the Secondary Connections button.

In the Secondary Connections dialog, click the Add button and specify a server name or IP
address. This should be a server hosting a secondary RAS Secure Gateway (the primary
gateway is used by the primary connection). You can click the [...] button and select a server
from the list. If none are available (or if the desired server is not in the list), type the server info in
the field provided.
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3 Select the connection mode and modify the port number if necessary. Click OK.

4 Back in the Secondary Connections dialog, you can move connections up or down the list if
you have more than one. If the primary connection cannot be established, Parallels Client will
use secondary connections in the order listed.

5 Click OK.

Configuring the Logon Information

In the Logon section, specify the following properties:

1 Select the Auto start option to enable Parallels Client to connect automatically (using this
connection) on startup.

2 In the Authentication type drop-down list, select the desired method of authentication:

Credentials: Select this option and then enter the username, password, and domain
information. You will be authenticated on the remote server using the specified credentials.
Smart Card: Select this option to authenticate using a smart card. When connecting to the
remote server, insert a smart card into the card reader and then enter a PIN when prompted.
Single Sign-On: This option will be included in the list only if the Single Sign-On module is
installed during Parallels Client installation. Select this option to use local system credentials
to connect to the remote server.

Web: Select this option to use the SAML SSO authentication.

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in
Connection / Authentication.
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Display
The Display tab page allows you to configure display options.
Connection Properties - My RAS Connection ? X
Experience Network Server authentication Advanced settings
Connection Display Printing Scanning Local resources

General options
Color depth: High Color(16 bit) i

Full Screen

Published applications

[:] Use primary monitor only
Use dynamic desktop resizing

Desktop options
Display configuration: All ~ Configure
Smart-sizing: Resize (update resolution) v
Connection bar in full screen: Show pinned v

[ ] Embed desktop in launcher (Classic interface only)

Span desktop across all monitors

'6' This connection is FIPS compliant.

General Options

= Color Depth: Specify the desired color depth.
= Size: This option is available for standard RDP connections only.

< Use all monitors for desktop session (if applicable): Select this option to use all monitors (if
you have more than one).

Published Applications

= Use primary monitor only: Display a published resource on the primary monitor only. Other
monitors connected to the computer will not be used.
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Use dynamic desktop resizing: Select this option if you want published resources to use the
display settings of the local desktop.

Desktop Options

Display configuration: Choose which monitors will be used to display published resources. The
following options are available:

= All: All displays.

= Primary: Your primary display. You can change the primary display as described below.

= Selected: Choose one or several displays manually. To choose a display, select this option
and click Configure. To see what number corresponds to a display, click Identify.
Newly connected displays are detected automatically. To force Client to detect new displays,
click Identify.
To change the primary display, select the display you want to be primary and click Set
primary.
Smart-sizing: Choose a smart sizing option. The Scale (fit to window) option scales a remote
desktop to fit the connection window. The Resize (update resolution) option updates the
resolution dynamically (without the need to reconnect) based on the window size, which means
that as soon as you resize the window, the resolution is dynamically changed. To disable smart
sizing, select Disabled.
Embed desktop in launcher: Enable this option to open a remote desktop inside the Parallels
Client window (launcher).
Span desktop across all monitors: Enable this option to span published desktops across all
connected monitors.
Connection bar in full screen: Choose how the connection bar should be displayed in full
screen mode by default: pinned, unpinned, or hidden.
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Printing
The Printing tab page allows you to configure printing options.
Connection Properties - My RAS Connection ? X
Experience Network Server authentication Advanced settings
Connection Display Printing Scanning Local resources
Technology
Use: RAS Universal Printing technology ~

RAS Universal Printing

Redirect printers:  All i
Name
(] Microsoft Print to PDF
(]10.100.7.18
Options...

Default printer

The default printer '10.100.7.18' redirected using RAS Universal Printing
technology will be set as default on the remote host.

Change default printer settings...

'6' This connection is FIPS compliant.

In the Technology drop-down list, select the technology to use when redirecting printers to a
remote computer:
= None. Don't redirect printers.

= RAS Universal Printing technology. Select this option if you want to use RAS Universal
Printing technology.

= Microsoft Basic Printing Redirection technology. Select this option if you want to use
Microsoft Basic printing technology.

= RAS Universal Printing and Microsoft Basic redirection technologies. Select this option to
use both Parallels RAS and Microsoft technologies.
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RAS Universal Printing

If you selected RAS Universal Printing technology, select printers to redirect in the Redirect

Printers drop-down list:

< All. All printers on the client side will be redirected.

e Default only. Only the Windows default printer will be redirected.

= Specific only. Select the printers to redirect from the provided list. The list becomes enabled
only if you select this option.

The Options button opens the RAS Universal Printing Options dialog where you can configure
additional printing options as described below.

In the Choose Format drop-down list, select a data format for printing:

Print Portable Document Format (PDF). Adobe PDF. This option does NOT require you to
install any local applications capable of printing a PDF document. All the necessary libraries are
already installed together with Parallels Client.

Note: This option is not available in Parallels Client for ARM64. However, printing to PDF is possible by
using the native Microsoft Print to PDF redirected printer.

= View PDF with external application. To use this option you must have a local application
installed which is capable of viewing a PDF document. Note that not all applications are
supported. For example, the built-in PDF viewer in Windows is not supported, so you must have
Adobe Acrobat Reader (or a similar application) installed.

= Print PDF with external application. This option works similar to the View PDF option above. It
also requires an application capable of printing a PDF document installed locally.

= Enhanced Meta File (EMF). Use vector format and embedded fonts.

= Bitmap (BMP). Bitmap images.

In the Client Printer Preferences section, select one of the following:

= Use server preferences for all printers. If this option is selected, a generic printer preferences
dialog will be shown when you click Print in a remote application. The dialog has only a minimal
set of options that you can choose.

e Use client preferences for all printers. With this option selected, a local printer preferences
dialog will open when you click Print in an application. The dialog will contain a full set of options
for a particular printer that you have installed on your local computer. If you have more than one
printer installed, a native preferences dialog will open for any particular printer that you choose to
print to.

= Use client preferences for the following printers. You can use this option when you have
more than one printer installed on your local computer. This option works similar to the Use
client preferences for all printers option (above), but allows you to select which printers
should use it. If a printer is not selected, it will use the generic printer preferences dialog, similar
to the first option in this list.

Default printer settings

To configure default printer settings, click the Change Default Printer settings button.
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The default printer list shows printers that can be redirected. The list also includes the printing
technology which the available printers will use. The technology reflects the setting selected in the
Technology section. For example, if the technology was set to RAS Universal

Printing technology, only the printers using RAS Universal Printing will be listed.

To disable the default printer, select <none>. To redirect the default local printer on the client side to
the remote computer, select <defaultlocalprinter>. WWhen <custom printer> is selected, you can
specify a custom printer which might be installed on the remote computer. The first printer that
matches the printer name inserted in the custom text box, will be set as the default printer on the
remote computer.

Select Match exact printer name to match the name exactly as inserted in the custom text box.
Please note that the remote printer name may be different than the original printer name. Also note
that local printers may not redirect due to server settings or policies.

You can specify the time a printer will be forced as default. If the default printer is changed during
this time after the connection is established, the printer is reset as default.

Select the Update the remote default printer if the local default printer is changed option to
change the remote default printer automatically when the local default printer is changed. Please
note that the new printer must have been previously redirected.

Note for Windows 10 users

Windows 10 has a feature that automatically sets the default printer to the one used most recently
or more often. This can cause the default printer settings on a remote server to become invalid. To
resolve this issue, the default printer management in Windows 10 should be disabled. This can be
done for your by the IT administrator using the Group Policy or it can be done locally as follows:

1 Click Start and then click the "gear" icon which will open the Settings page.

2 (lick Printers and Scanners.

3 Turn the Let Windows manage my default printer option to OFF.

4 Turn the Download over metered connections option to ON.
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Scanning

On the Scanning tab page, you can specify a specific scanner that should be used when one is
required by a published resource.

Connection Properties - My RAS Connection ? X
Experience Network Server authentication Advanced settings
Connection Display Printing Scanning Local resources
Technology

Use: TWAIN 7

RAS Universal Scanning

Redirect scanners:  All v

Name

'o' This connection is FIPS compliant.

Use. Allows you to select a scanning technology. RAS Universal Scanning uses TWAIN and WIA
redirection allowing an application to use either technology depending on the hardware type
connected to the local computer. If you select None, scanning will disabled.

Redirect Scanners. Select scanners attached to your computer for redirection. You can select
All (all attached scanners will be redirected) or Specific only (only the scanners you select in the
provided list will be redirected).
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Local resources

Use the Local resources tab page to configure how local resources are used in a remote session.

Connection Properties - My RAS Connection ? X
Experience Network Server authentication Advanced settings
Connection Display Printing Scanning Local resources

Remote audio

Configure remote audio settings.
Settings...

Keyboard

Apply Windows key combinations for desktops only
(for example ALT+TAB)

On the remote computer v
Local devices and resources

Choose the device and resources that you want to use in your remote session.

P clipboard

Bpisk drives

& video capture devices
DOther supported devices

B serial ports

B smart cards

@ Pen and touch input

[ JMultimedia redirection for AVD

Configure ...

'ﬁ' This connection is FIPS compliant.

Audio
Click the Settings button to configure remote audio playback and recording options.

In the Remote audio playback section, Use the Where drop-down list to select one of the
following remote audio playback options:
= Bring to this computer. Audio from the remote computer will play on your local computer.

= Do not play. Audio from the remote computer will not play on your local computer and will be
muted on the remote computer as well.

= Leave at remote computer. Audio will not play on your local computer but will play normally on
the remote computer.

Use the Quality drop-down list to adjust the audio quality:
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= Dynamically adjust based on available bandwidth. This option will increase or decrease the
audio quality based on your connection speed. The faster the connection, the higher audio
quality setting will be used.

= Always use medium audio quality. The audio quality is fixed at the medium level. You can use
this option when you don't require the best possible audio quality and would rather use the
available bandwidth for graphics.

= Always use uncompressed audio quality. The audio quality is fixed at the highest level. Select
this option if you have a very fast connection and require the best possible audio quality.

The Enable recording (if applicable) option allows you to enable audio recording on the remote
computer. For example, you can speak into a microphone on the local computer and use a sound
recording application on the remote computer to record yourself.

Keyboard

Select how you want to apply key combinations (e.g. Alt+Tab) that you press on the keyboard:

= On the local computer. Key combinations will be applied to Windows running on the local
computer.

= On the remote computer. Key combinations will be applied to Windows running on the remote
computer.

= In full screen mode only. Key combinations will be applied to the remote computer only when
in the full-screen mode.

Local Devices and Resources

Choose local disk drives, devices, and other resources that you want to redirect to a remote
computer. Redirecting a resource makes it available for use in a remote session. For example, a
redirected local disk drive will be available in a remote application, so you can read from and write to
it.

The following options are available:

= Clipboard. Select this option to enable the clipboard in a remote session. Click the Configure
button and choose clipboard redirection from one of the following: Bidirectional (allows to copy
in both directions), Server to client only, Client to server only.

= Disk drives. Select this option and then click Configure Drives. In the dialog that opens, select
local drives you want to redirect. If you select the Use also disk drives that | plug in later
option, disk drives that you connect to your local machine later will be automatically available in a
remote session. You can also use the Enable drive redirection cache option to make file
browsing and navigation on the redirected drives much faster:
= Disable: Drive redirection cache is disabled.
= Enable: Drive redirection cache is enabled.
« Fast mode: Same as above, but certain decorative features of File Explorer are disabled in

favor of faster browsing. This option is supported in Parallels Client for Windows only.
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= Video capture devices. Specifies video capture devices to redirect from a user device to the
remote session. This is a high-level redirection that allows to redirect a composite USB device,
such as a webcam with a microphone. When this option is selected and you click Configure, a
dialog opens where you can select a particular device or select one of following options: Use all
devices available — all currently connected devices will be used; Use also devices that | plug
in later — a device that is plugged in after a session is started will also be used.

= Other supported devices. Select this option and then click Configure Devices. Devices that
are currently connected to your local computer will appear in the list. This includes supported
Plug and Play devices, media players based on the Media Transfer Protocol (MTP), and digital
cameras based on the Picture Transfer Protocol (PTP). If a device is connected to your
computer but does not appear in the list, it means it is not a supported Plug and Play device.
Please note that disk drives and smart cards are excluded from this list (you redirect them using
dedicated Disk drives and Smart cards options). The Show previously connected devices
option displays devices that are not currently connected but were connected previously.

= Serial ports. Select this option to redirect serial ports.

= Smart cards. Select this option to redirect smart cards.

= Pen and touch input. Enables or disables Windows touch input redirection. Windows touch
input redirection allows the user to use Windows native touch gestures from touch-enabled
devices, including touch, hold, and release actions. The actions are redirected to remote
applications and desktops as corresponding mouse clicks. This option allows you to disable
touch input redirection in case of app compatibility issues.

= Multimedia redirection for AVD. Allows to watch video content played in a browser on a
remote Azure Virtual Desktop host.

Note: This policy is applicable to Parallels Client for Windows 10 1909 and later, and Windows 11.

Note: Multimedia redirection on Azure Virtual Desktop is currently in preview. For the list of web sites
that support multimedia redirection, see
https://learn.microsoft.com/en-us/azure/virtual-desktop/multimedia-redirection-intro.

Experience

The Experience tab page allows you to tweak the connection speed to optimize the performance of
the connection with the remote server.

In the drop-down list, select your connection speed:

= |f not sure, select the Detect connection quality automatically option. Please note that if you
select this option, all other options, except Enable Compression, will be disabled and will be
configured automatically based on the actual connection speed when Parallels Client is
connected to Parallels RAS.

= If you select a specific speed (e.g. LAN 10 Mbps or higher), select the desired user experience
options. If you are connecting to a remote computer on a local network that runs at 100 Mbps or
higher, it is usually safe to have all of the experience options turned on. Otherwise, select only
the options that you require.

It is also recommended to enable compression to have a more efficient connection by selecting the
Enable Compression option.
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Enhance windows move/size: Enable this option if you experience graphics artifacts (dark
squares) while moving or resizing a remote application window. The issue may manifest itself when
an application is hosted on Windows Server 2012 or 2016 and when the Show contents of
window while dragging option is enabled.

Network

Use the Network tab page to configure a proxy server if you have to use one to connect to Parallels
RAS.

To configure a proxy server, select the Use proxy server option and then select the protocol from
the following list:

e SOCKS4. Enable this option to transparently use the service of a network firewall.

e SOCKS4A. Enable this option to allow a client that cannot connect to resolve the destination
host’s name to specify it.

e SOCKSS5. Enable this option to be able to connect using authentication.
= HTTP 1.1. Enable this option to connect using a standard HTTP 1.1 protocol connection.

Specify the proxy host domain name or IP address and the port number.

For SOCKS5 and HTTP 1.1 protocols, select Proxy requires authentication and enter user
credentials.

Server authentication
Use the Server authentication tab page to specify what happens if the server authentication fails.
In the If authentication fails drop-down list, select one of the following options:

= Connect. The user can ignore the certificate of the server and still connect.

= Warn. The user is alerted about the certificate and still has the ability to choose whether to
connect or not.

= Do not connect. The user is not allowed to connect.
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Advanced Settings

The Advanced Settings tab page allows you to customize the default behavior or Parallels Client.

Connection Properties - My RAS Connection

Connection Display Printing Scanning

X

Local resources

Experience Network Server authentication Advanced settings

Advanced settings

Change default behavior of Parallels Client.

Use client system colors

Use client system settings (border size, fonts, etc)
Create shortcuts configured on server

Register file extensions associated from the server
(] Redirect URLs to the client device

[ JRedirect MAILTO to the client device

(] Always ask for credentials when starting applications
& Allow Server to send commands to be executed by client
Confirm Server commands before executing them
Network Level Authentication

(] Redirect POS devices

() Use Pre Windows 2000 login format

() Disable RDP-UDP for gateway connections

Connection advanced settings...

'ﬁ' This connection is FIPS compliant.

You can specify the following properties:
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Use client system colors. Enable this option to use the client system colors instead of those

specified on the remote desktop.

Use client system settings. Enable this option to use the client system settings instead of

those specified on the terminal server.

Create shortcuts configured on server. For each published application, the administrator can
configure shortcuts that can be created on the client's desktop and the Start menu. Select this
option to create the shortcuts, or clear the option if you don't want to create them.

Register file extensions associated from the server. For each published application, the
administrator can create file extension associations. Use this option to either register the

associated file extensions or not.
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Redirect URLs to this computer. Enable this option to use the local web browser when
opening 'http:" links.

Redirect Mail to this computer. Enable this option to use the local mail client when opening
‘mailto:’ links.

Always ask for credentials when starting applications. If this option is enabled, the user will
be prompted to enter their credentials when starting applications.

Allow Server to send commands to be executed by client. Enable this option to allow
commands being received from the server to be executed by the client.

Confirm Server commands before executing them. If this option is enabled, a message is
displayed on the client to confirm any commands before they are executed from the server.

Network Level Authentication. Check this option to enable network level authentication, which
will require the client to authenticate before connecting to the server.

Redirect POS devices. Enables the Point of Service (POS) devices such as bar code scanners
or magnetic readers that are attached to the local computer to be used in the remote
connection.

Use Pre Windows 2000 login format. If this option is selected, it allows you to use legacy
(pre-Windows 2000) login format.

Disable RDP-UDP for gateway connections. Disable UDP transport when connecting
through a gateway.
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Connection Advanced Settings

Click the Connection Advanced Settings button to configure the additional settings.

Connection Advanced Settings ? X
Connection  Authentication Advanced

Connection

Connection timeout: @ seconds

Show connection banner if connection is not established within 5 seconds
Show desktop if published application does not start within 30 seconds
Reconnection

Reconnect if connection is dropped

Connection Retries: 10

Show connection banner if re-connection is not established within 5 seconds

Session prelaunch

Mode: Off hd
Local proxy address

Use 127.0.0.1 IP address when using Gateway mode in VPN scenarios

Connection tab:

= Connection timeout. The amount of time during which the client will try to connect to Parallels
RAS until the connection is aborted. While the connection is being established, the connection
banner will be shown.

< Show connection banner if connection is not established within. Specifies the time period
in seconds after which the connection banner will be displayed.

< Show desktop if published application does not start within. If a published application is not
launched within the time period specified in this field, the server’s desktop will be loaded. This is

helpful if an error occurs on the server while launching an application. By loading the server’s
desktop, the error can be seen.

= Reconnect if connection is dropped. Select this option and set the number of Connection
Retries. If a connection is dropped, the Parallels Client will automatically try to reconnect.
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= Session prelaunch. Enables session prelaunch. This will make a remote application appear to
start faster. Use the Mode drop-down list to select Basic or Machine Learning. If you select
Basic, a session will be launched when Parallels Client gets the application listing. Because the
session will be launched some time before you start an application, it will take less time to open
the app. Please note that for the Basic mode to start working for this connection, you need to
enable it and then run an application using this connection for at least 15 minutes. This is to
prevent session prelaunch in connections that are not actively used.

The Machine Learning option will record and analyze your habits of starting applications and
will prelaunch a session a few minutes before you usually open an application on a given day of
the week.

= Local proxy address. The setting in this section specifies on which IP address to bind the local
RDP proxy. Select the Use 127.0.01 IP address when using Gateway mode in VPN
scenarios option. You should have this setting enabled. Disabling it may lead to the user not
being able to open applications or desktops when using a VPN.

Authentication tab:

Options on this tab are used when Web is selected as authentication type.

< Browser mode. Select whether to open the web authentication page via the browser built into
the Parallels Client or a browser installed on the host computer.

« External browser. Select the browser to open the web authentication page.

= Open browser in Incognito mode. Select this option to open the selected external browser in
Incognito mode.

< Open browser window to complete log out. Select this option to open a SAML log out dialog
in the built-in browser

« Remember last method used. If selected, the last MFA authentication method is remembered
and will be used by default.

Note for Administrators: To launch web authentication page with built-in browser while using Parallels
RAS Console 19.3 or later, use Parallels RAS Client for Windows 19.3 or later.

Advanced tab:

= Override computer name. Specifies the name that your computer will use during a remote
desktop session. If set, this will override the default computer name. Any filtering set by the
administrator on the server side will make use of the Override computer name.

Using a RAS Connection

To connect to Parallels RAS, click the Navigation button and double-click the connection
(right-click the connection and choose Connect in classic interface).

Launching Published Resources (Modern Interface)

After you connect to Parallels RAS, Parallels Client is populated with published folders. When you
select a folder, the resources that it contains are displayed. If your administrator hasn't published
any folders, then the available resources are displayed when you select the connection itself.
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Important: If you are using Azure Virtual Desktop in Parallels RAS 19.3, you need to update Parallels
Client to version 19.3.

| a Parallels Client = 0 ®
|

= My RAS Connection

Favorites All apps Mo~ 82 . = e

- All apps > RDSH

G ® F @ & B < &

Desktop AppPackage RDSH Regicn Control Panel Keyboard notepad
Folder Managemen... Desktop Properties
» R 1 :; » e —
oF \ = | H L [} L U‘
b e, @ i b,
Paint Wordpad Computer Event Viewer Registry Editor Task Manager Calculator Command
Management Prompt
e o
msedge wmplayer Individual

server items

To launch a resource, double-click it. The resource will open on your Windows desktop. You can
also open a resource by right-clicking it and then selecting Open in the context menu. Please note
that there could be a slight delay before the application opens. If during this delay you double-click
the resource again, Parallels Client will ignore it (i.e. the application will not be launched twice).
Favorites

The Favorites tab allows you to quickly access frequently used applications.

To add an item to the Favorites tab:

Right-click the item you want to add and select Add to Favorites from the context menu or click
on the star icon near the item.

To delete an item from the Favorites tab:

Right-click the item you want to remove and select Remove from Favorites from the context menu
or click on the star icon near the item.

Toolbar

The two-tier toolbar is displayed at the top of the main Parallels Client window. Using the toolbar
items you can:

= Switch between RAS connections and RDP connections.
= Open the main menu (see below).
= Opening the Manage connections menu (see below).
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Change the published resources view to display resources as icons or as a list.
Sort resources in different ways.
Search for a resource in the Search box.

Main menu

Main menu allows you to do the following:

New connection. Add a new connection.

Session information. See network performance (p. 42).
Import settings. Import Parallels Client settings (p. 58).

Export settings. Export Parallels Client settings (p. 58).

Settings. Open global options (p. 55).

Delete all shortcuts from desktop. Delete shortcuts for all published resources from the
desktop of the host computer.

Parallels Client Help. Open this guide.
About. See Parallels Client version.

Manage connection menu

Manage connections menu allows you to do the following:

Connect. Connect using the saved credentials.

Refresh. Refresh the published resources view. The information is re-retrieved from the remote
server.

Disconnect. Disconnect from the sessions without logging out.

Log Out. Log out and end the session on the remote server. All opened remote applications will
be closed, so you should save your work before using this option.

Connection properties. Open connection properties.

Change Domain Password. Change the current user's domain password. Opens the Logon
dialog where you need to type your current domain password to be authenticated. Click OK to
open the Change Domain Password dialog and type a new password in both fields. The
password must meet the requirements set by your system administrator. The requirements are
displayed in the dialog, and the password that you enter is validated against these requirements.
To proceed with changing your password, all of the requirements must be met.

Create shortcut on desktop for selected item. Create a shortcut for a single selected
applications on your desktop.

Create shortcuts on desktop for favorite items. Create shortcuts for all applications added to
Favorites on your desktop.

Delete Connection. Delete the current connection.
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Launching Published Resources (Classic Interface)

After you connect to Parallels RAS, the Connections pane is populated with published folders.
When you select a folder in the left pane, the resources that it contains are displayed in the right
pane. If your administrator hasn't published any folders, then the available resources are displayed in
the right pane when you select the connection itself.

Important: If you are using Azure Virtual Desktop in Parallels RAS 19.3, you need to update Parallels
Client to version 19.3.

5 Parallels Client - My RAS Connection — O >

File Applications Sessions Tools View Help

« = 1‘ | Connections » My RAS Connection |e H Search

v ‘ Connections

Infa
v I My RAS Connection Cal T 1 ey &3
Tools HH A s :

Tools Calculator Paint Wordpad Access 2013
B % 9
Ewcel 2013 Qutook 2013 PowerPoint  Word 2013 Skype
2013

10 items

Ed

To launch a resource, double-click it in the right pane. The resource will open on your Windows
desktop. You can also open a resource by selecting it in the right pane and then clicking
Applications > Open in the main menu. Please note that there could be a slight delay before the
application opens. If during this delay you double-click the resource again, Parallels Client will ignore
it (i.e. the application will not be launched twice).

By default, Parallels Client is configured to minimize to the system tray when you launch a resource.

To bring it back up, open the system tray, then right-click the Parallels Client icon and
choose Restore. To change this default behavior, click Tools > Options in the main menu, then
select the Advanced Settings tab and clear the Hide Launcher when application is launched
option.

You can navigate and customize the published resources view as follows:

= Use the arrows at the top of the left pane to navigate the Connections tree left, right, or up.
= Expand an active connection node to view published folders (when they are available).

40



Using Parallels Client for Windows

Click a part of the navigation string (e.g. Connections > My RAS Connection > Applications) to
display the corresponding tree node.

Click the recycle icon to refresh the published resources view. If there were changes on the
server side, they will be reflected in Parallels Client.

Use the Search box to search for a resource. The list will be filtered as you type. To remove the
filter, clear the box.

Use the View menu item to display published resources as icons, tiles, list, etc. To quickly switch
between icons and a detailed list, click one of the two icons in the lower right corner of the main
window.

Working with Remote Applications

When a remote application is launched on your PC, you can work with it just like you would with a
local application, which includes the following standard tasks:

Open local files in the application.

Create new files and save them locally.

Maximize and minimize the application (if it has the controls for it).
Move the application around Windows desktop.

Pin the application icon to taskbar (the icon will stay in taskbar even after you close Parallels
Client).

Print documents or graphics to a local printer.
Use a local scanner.

Drag and drop functionality

You can drag and drop files to and from remote applications. For example, you can drag and drop a
local file to a remote application to open it, or you can drag and drop a file from the remote Windows
Explorer to the local Explorer. You can also drag and drop objects like images and text from/to
remote applications. Some limitations apply, so it may not work for all types of files and applications.
The list bellow describes formats that are supported:

Files — files can be dragged from Windows Explorer and dropped to a remote application. The
remote application will open the file given that it has access to the file itself. Any changes are
done to the original file.

Virtual file contents — dragging of virtual files similar to dragging attachments from a mail client
to a remote application. A copy of the file is used temporarily. Usually the original file is not
modified.

Global data formats — dragging of elements like images or text blocks. This highly depends on
the format itself, so it is not guaranteed that all applications and formats will work.

EMF format — when combining images and text, some applications convert the data into EMF
(Enhanced Metafile), which is supported.
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When you drag and drop a file or an object that contains a large amount of data, a notification dialog
will be shown on the screen while the operation is in progress. The dialog will display the info that
drag and drop is in progress and will contain the RAS connection name to or from which the data is
being transfered. Please note that while drag and drop is in progress, you cannot interact with the
source and destination folders or applications, so you have to wait until the notification dialog
closes.

Assessing Network Performance

When users experience poor performance while working with remote applications or desktops in
Parallels Client, the issue may not be related to back-end Parallels RAS components, but simply due
to poor network conditions. Parallels Client provides you with the ability to assess network
performance while an active session is running.

To asses network performance, click main menu > Session Information. The Sessions dialog
opens where you can view active session information.

a Sessions — ot
Sessions:
iion Server Connection Quality  Latency Bandwidth Usernam Refresh
10.211.55.5 Excellent Show Information
Disconnect
Logoff

Close

The columns in the Sessions table are:

e Session. Session name.

e Server. Remote server name or IP address.

= Connection Quality. Can be one of the following: Poor, Fair, Good, Excellent.
= Latency. Connection round-trip delay time, in milliseconds.

= Bandwidth. Connection bandwidth.

= Username. Username of the session owner.

e Domain. Domain name.

= Type. Connection type (RAS or RDP).
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The Connection Quality, Latency, and Bandwidth column values should give you enough
information to identify poor network conditions. If network performance is not as expected, you can
address the issue from this perspective. You can also view the connection quality information on the
Session Information dialog (Connection Quality section). To open the dialog, select a session and
click the Show Information button.

The buttons in the Sessions dialog allow you to perform the following actions:

« Refresh. Refresh the Sessions list.

= Show Information. Display additional session information, including credentials and the
Gateway used, connection mode, encryption, and others.

« Disconnect. Disconnect from Parallels RAS. The resource (or resources) will be closed on your
local desktop, but will continue to run on the remote server. If you open the resource after that,
your work will be where you left it. If you had more than one instance of a resource opened
before you disconnected from Parallels RAS, all of them will open on your desktop.

= Logoff. End the session. This will close all running resources on the remote server. You should
save all your data before ending a session.

« Close. Close the Sessions dialog.

Changing Your Domain Account Password
If you need to change your domain account password, you can do it right from Parallels Client.

Note: If your domain password will expire soon, you will see a notification in the Windows taskbar (above
the Parallels Client icon) when you connect to Parallels RAS. To change your domain password at that
time, click on the notification itself, which will open the Change Domain Password dialog, or you can
close the notification and change the password later as described below.

To change your domain password (if required or for any other reason):

1 Click Main menu > Change Domain Password (or right-click a connection and choose
Change Domain Password).

2 Inthe Logon dialog, type your current password and click OK.

3 Inthe Change Domain Password dialog, enter a new password in both fields. The password
must meet the requirements set by your system administrator. The requirements are displayed in
the dialog, and the password that you enter is validated against these requirements. To proceed
with changing your password, all of the requirements must be met.

4 Once the password requirements are met, click Change Password.

Your domain account password is now changed. Your existing connections in Parallels Client are
automatically updated to use the new password.
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Configuring an RDP Connection

To modify the properties of an existing standard RDP connection, click the Navigation button,
select RDP connections, right-click the connection and then click Connection Properties in the
context menu (right-click it in the main Parallels Client window and then click Connection
Properties in the context menu in classic interface). This will open the Connection Properties
dialog. Properties are grouped in the dialog by functionality using tab pages. The following
subsections describe each tab page in detalil.

= (Connection

= Display

= Local resources

= Programs

= Experience

= Network

= Server authentication

= Advanced settings
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Connection
The Connection tab page allows you to specify connection settings and logon information.
Connection Properties - My RDP Connection ?
Experience Network Server authentication Advanced settings
Connection Display Local resources Programs

Connection settings

?: Primary connection:

Connection mode: RDP

Port: 3389
Secondary connections...
Name: My RDP Connection
Login
3 [ ] Auto login
Authentication type: Credentials v
Username:
Password:
Save password
Domain:

oK Cancel Help

In the Connection Settings section, specify the following properties:

1 In the Primary Connection field, specify the remote computer hostname or IP address.

2 The Port field contains the TCP port 3389 by default, which is the standard port for RDP
connections. You can maodify it if the port number was changed on the remote computer.

3 Inthe Friendly Name field, choose and type a name of your choice, so you could easily identify
the server in Parallels Client later.

In the Logon section, specify the following properties:

1 Select the Auto start option to enable Parallels Client to connect automatically (using this
connection) on startup.

2 In the Authentication type drop-down list, select the desired method of authentication:
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= Credentials. Select this option and then enter the username, password, and domain
information. You will be authenticated on the remote server using the specified credentials.

« Smart Card. Select this option to authenticate using a smart card. When connecting to the
remote server, insert a smart card into the card reader and then enter a PIN when prompted.

= Single Sign-On. This option will be included in the list only if the Single Sign-On module is
installed during Parallels Client installation. Select this option to use local system credentials
to connect to the remote server.

= Web: Select this option to use the SAML SSO authentication.

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in
Connection / Authentication.

Display

The Display tab page allows you to configure display options.

Experience Network Server authentication Advanced settings

Connection Display Local resources Programs
General options
Color depth: High Color(16 bit) v

Size: Full Screen i

Published applications

D Use primary monitor only
Use dynamic desktop resizing

Desktop options
Display configuration: All ~ Configure
Smart-sizing: Resize (update resolution) v
Connection bar in full screen: Show pinned v

Embed desktop in launcher (Classic interface only)

Span desktop across all monitors

oK Cancel Help
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In the General Options section, specify the general display properties, including color depth and
screen size. If you would like to specify a custom screen size, select Custom in the drop-down list
and then specify the size using the Width and Height fields.

If you have more than one monitor connected to your computer, select the Use all monitors for
Desktop session option to use all of them to display the remote desktop.

Specify the Desktop Options as follows:

= Display configuration: Choose which monitors will be used to display published resources. The
following options are available:
= All: All displays.
= Primary: Your primary display. You can change the primary display as described below.

= Selected: Choose one or several displays manually. To choose a display, select this option
and click Configure. To see what number corresponds to a display, click Identify.

Newly connected displays are detected automatically. To force Client to detect new displays,
click Identify.
To change the primary display, select the display you want to be primary and click Set
primary.
= Smart-sizing: Choose a smart sizing option. The Scale (fit to window) option scales a remote
desktop to fit the connection window. The Resize (update resolution) option updates the

resolution dynamically (without the need to reconnect) based on the display resolution. To
disable smart sizing, select Disabled.

< Embed desktop in launcher. Enable this option to access the published desktop inside
Parallels Client.

= Span desktop across all monitors. Enable this option to span the published desktops across
all connected monitors (if you have more than one).

= Connection bar in full screen: Choose how the connection bar should be displayed in full
screen mode by default: pinned, unpinned, or hidden.
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Local resources

Use the Local resources tab page to configure how local resources are used in a remote session.

Connection Properties - My RDP Connection ?
Experience Network Server authentication Advanced settings
Connection Display Local resources Programs

Remote audio

Configure remote audio settings.
Settings...

Keyboard

Apply Windows key combinations for desktops only
(for example ALT+TAB)

On the remote computer v
Local devices and resources

Choose the device and resources that you want to use in your remote session.

P clipboard

Bpisk drives

& video capture devices
DOther supported devices
B serial ports

B smart cards

@ Pen and touch input
Printers

Configure ...

oK Cancel Help

Audio
Click the Settings button to configure remote audio playback and recording options.

In the Remote audio playback section, Use the Where drop-down list to select one of the
following remote audio playback options:
= Bring to this computer. Audio from the remote computer will play on your local computer.

= Do not play. Audio from the remote computer will not play on your local computer and will be
muted on the remote computer as well.

= Leave at remote computer. Audio will not play on your local computer but will play normally on
the remote computer.

Use the Quality drop-down list to adjust the audio quality:
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= Dynamically adjust based on available bandwidth. This option will increase or decrease the
audio quality based on your connection speed. The faster the connection, the higher audio
quality setting will be used.

= Always use medium audio quality. The audio quality is fixed at the medium level. You can use
this option when you don't require the best possible audio quality and would rather use the
available bandwidth for graphics.

= Always use uncompressed audio quality. The audio quality is fixed at the highest level. Select
this option if you have a very fast connection and require the best possible audio quality.

The Enable recording (if applicable) option allows you to enable audio recording on the remote
computer. For example, you can speak into a microphone on the local computer and use a sound
recording application on the remote computer to record yourself.

Keyboard
Select how you want to apply key combinations (e.g. Alt+Tab) that you press on the keyboard:

= On the local computer. Key combinations will be applied to Windows running on the local
computer.

= On the remote computer. Key combinations will be applied to Windows running on the remote
computer.

= In full screen mode only. Key combinations will be applied to the remote computer only when
in the full-screen mode.

Local Devices

Choose local disk drives, devices, and other resources that you want to redirect to a remote
computer. Redirecting a resource makes it available for use in a remote session. For example, a
redirected local disk drive will be available in a remote application, so you can read from and write to
it.

The following options are available:

= Clipboard. Select this option to enable the local clipboard in a remote session.

= Disk drives. Select this option and then click Configure Drives. In the dialog that opens, select
local drives you want to redirect. If you select the Use also disk drives that | plug in later
option, disk drives that you connect to your local machine later will be automatically available in a
remote session. You can also use the Enable drive redirection cache option to make file
browsing and navigation on the redirected drives much faster:

= Disable: Drive redirection cache is disabled.

= Enabile: Drive redirection cache is enabled.

= Fast mode: Same as above, but certain decorative features of File Explorer are disabled in
favor of faster browsing.

= Video capture devices. Specifies video capture devices to redirect from a user device to the
remote session. This is a high-level redirection that allows to redirect a composite USB device,
such as a webcam with a microphone. When this option is selected and you click Configure, a
dialog opens where you can select a particular device or select one of following options: Use all
devices available — all currently connected devices will be used; Use also devices that | plug
in later — a device that is plugged in after a session is started will also be used.
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= Other supported devices. Select this option and then click Configure Devices. Devices that
are currently connected to your local computer will appear in the list. This includes supported
Plug and Play devices, media players based on the Media Transfer Protocol (MTP), and digital
cameras based on the Picture Transfer Protocol (PTP). If a device is connected to your
computer but does not appear in the list, it means it is not a supported Plug and Play device.
Please note that disk drives, printers, and smart cards are excluded from this list (you redirect
them using dedicated Disk drives, Printers, and Smart cards options). The Show previously
connected devices option displays devices that are not currently connected but were
connected previously.

= Serial ports. Select this option to redirect serial ports.
= Smart cards. Select this option to redirect smart cards.
= Printers. Select this option to redirect local printers.

Programs

The Programs tab page allows you to specify a program that will be started automatically on the
remote computer when you establish a connection with it. Select the Start the following program
on connection option and then specify the Program path and file name and Start in the
following folder option, if needed.

Experience

The Experience tab page allows you to tweak the connection speed to optimize the performance of
the connection with the remote server.

In the drop-down list, select your connection speed:

= |f not sure, select the Detect connection quality automatically option. Please note that if you
select this option, all other options, except Enable Compression, will be disabled and will be
configured automatically based on the actual connection speed when Parallels Client is
connected to Parallels RAS.

= If you select a specific speed (e.g. LAN 10 Mbps or higher), select the desired user experience
options. If you are connecting to a remote computer on a local network that runs at 100 Mbps or
higher, it is usually safe to have all of the experience options turned on. Otherwise, select only
the options that you require.

It is also recommended to enable compression to have a more efficient connection by selecting the
Enable Compression option.

Enhance windows move/size: Enable this option if you experience graphics artifacts (dark
squares) while moving or resizing a remote desktop window. The issue may manifest itself when a
remote desktop is Windows Server 2012 or 2016 and when the Show contents of window while
dragging option is enabled.

Network

Use the Network tab page to configure a proxy server if you have to use one to connect to the
remote computer.
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To configure a proxy server, select the Use proxy server option and then select the protocol from
the following list:

< SOCKS4. Enable this option to transparently use the service of a network firewall.

e SOCKS4A. Enable this option to allow a client that cannot connect to resolve the destination
host’s name to specify it.

= SOCKSS5. Enable this option to be able to connect using authentication.
= HTTP 1.1. Enable this option to connect using the standard HTTP 1.1 protocol connections.

Specify the proxy host domain name or IP address and the port number.

For SOCKS5 and HTTP 1.1 protocols, select Proxy requires authentication and enter user
credentials.

Server authentication
Use the Server authentication tab page to specify what happens if server authentication fails.
In the If authentication fails drop-down list, select one of the following options:

= Connect. The user can ignore the certificate of the server and still connect.

e Warn. The user is alerted about the certificate and still has the ability to choose whether to
connect or not.

= Do not connect. The user is not allowed to connect.
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Advanced settings

The Advanced settings tab page allows you to customize the default behavior or Parallels Client.

Connection Display Local resources Programs
Experience Network Server authentication Advanced settings

Advanced settings

Change default behavior of Parallels Client.

(] Connect to console

Network Level Authentication

() Redirect POS devices

(] Use Pre Windows 2000 login format

Connection advanced settings...

oK Cancel Help

You can specify the following properties:
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Connect to console. This option is used for administration of a Remote Desktop Session Host
server. It acts as if a standard Remote Desktop connection is initiated from the command line
with the Zadmin option.

Network Level Authentication. Select this option to enable network level authentication, which
will require the client to authenticate before connecting to the server.

Redirect POS devices. Enables the Point of Service (POS) devices such as bar code scanners
or magnetic readers that are attached to the local computer to be used in the remote
connection.

Use Pre Windows 2000 login format. If this option is selected, it allows you to use legacy
(pre-Windows 2000) login format.
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Connection Advanced Settings
Click the Connection Advanced Settings button to open the Connection Advanced Settings
dialog and specify the following properties:

Connection Advanced Settings ? X
Connection  Advanced

Connection

Connection timeout: @ seconds

Show connection banner if connection is not established within 5 seconds

Reconnection
Reconnect if connection is dropped
Connection Retries: 10

Show connection banner if re-connection is not established within 5 seconds

Local proxy address

Use 127.0.0.1 IP address when using Gateway mode in VPN scenarios

oK ‘ Cancel Help

= Connection Timeout. The amount of time Parallels Client will try to connect to the remote
computer until the connection is aborted. While the connection is being established, the
connection banner will be shown.

= Show connection banner if connection is not established within. Specifies the time period
in seconds after which the connection banner will be displayed.

< Reconnect if connection is dropped. Select this option and set the number of Connection
Retries. If a connection is dropped, the Parallels Client will automatically try to reconnect.

= Show Connection Banner if reconnection is not established within. Specifies the time
period in seconds after which the connection banner will be displayed.
= Override computer name. Specifies the name that your computer will use during a remote

desktop session. If set, this will override the default computer name. Any filtering set by the
administrator on the server side will make use of the Override computer name.
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= Local proxy address. The setting in this section specifies on which IP address to bind the local
RDP proxy. Select the Use 127.0.01 IP address when using Gateway mode in VPN
scenarios option. You should have this setting enabled. Disabling it may lead to the user not
being able to open applications or desktops when using a VPN.

Using an RDP Connection

After adding a Standard Remote Desktop connection, click the Navigation button, select RDP
connections, double-click the connection (or right-click > Connect) to establish a connection with
the remote computer (right-click > Connect in classic interface).

You can have multiple active connections at the same time (both standard RDP and Parallels RAS).
To switch between active connections in Parallels Client, click the Navigation button, and select a
connection you want to switch to.

Right-click an active RDP connection to perform the following actions:

= Connect. This item is disabled for an active connection.
= Disconnect. Disconnects the selected connection.

= Connection Properties. Opens the Connection Properties dialog where you can configure the
connection. See Configuring an RDP Connection for details (p. 44).

= Smart Sizing. If enabled, smart-sizing will resize the remote desktop so it fits the available area.
= Send Ctrl+Alt+Del. Sends Ctrl+Alt+Del to the remote computer.

= Create Shortcut on Desktop. Creates a shortcut for this connection on the local desktop.

= Delete connection. Deletes the connection.

Using multiple monitors

If you have more than one monitor attached to your local computer, you can move the remote
desktop to the monitor of your choice. When you disconnect from the remote desktop and then
reconnect to it later, your monitor choice is remembered, so the remote desktop is displayed on the
same monitor as the last time. If the monitor is no longer available, the remote desktop will be
displayed on the default monitor.
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Configure Global Options

To configure Parallels Client global options, click the Navigation button and select Settings (Tools
> Settings in classic interface).

Settings ? X

General |ogging Update Single Sign-On  Advanced settings

Appearance

Use modern interface

Application appearance: System 7
Connection
Connection banner: Splash Window &

& Automatically refresh connected RAS connections every

60 minutes
When all sessions are closed: Do nothing v
|
General

« Use modern interface. Specifies whether to use modern interface.
= Application appearance. Specifies the theme used by Parallels Client.

= Connection Banner. Connection banner is shown when the Parallels Client is connecting to a
server or a desktop. You can choose to have a Splash Window, a Taskbar Toast Window icon,
or you can choose to hide the connection banner.

= Automatically refresh connected RAS connection every. Specifies the auto refresh time
frame for each connection.

< When all sessions are closed. Specifies what happens when all user sessions are closed:
= Do nothing. Nothing happens.
= Lock workstation. The computer is locked.
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= Sign out from workstation. The current user is signed out from their account.

Logging
Allows you to set logging level. The View and Clear buttons allow you to view and erase the log file.

Update

= Check for updates on startup. This option is available only with administrative rights. If this
option is selected, Parallels Client will check for available Parallels Client updates on startup. You
can also click the button to check for updates.

Single Sign-On
On the Single Sign-On page, specify the SSO settings if your organization is using it.

1 Click the Enable button to enable SSO.

2 If your organization is using a third-party SSO component (other than the one provided by
Parallels RAS), select the Force to wrap third party SSO component option and then select
the provider.

3 The Copy GUID to Clipboard button is used to copy the ID of the SSO component to the
clipboard.
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Advanced Settings

The Advanced Settings tab page allows you to configure advanced options.

Settings ? X

General Logging Update Single Sign-On Advanced settings

Advanced settings
Change default behavior of Parallels Client.

Language: Default ~

[ Hide Launcher when application is launched

Launch automatically at Windows startup

(] Allow RDP redirection of other supported RemoteFX USB devices to all
Show connections tree (Classic interface only)

[ ]On close, keep the application running

(] Do not warn if server certificate is not verified

() Add RAS connection automatically when starting web or shortcut items
[ Do not show prompt message for auto add RAS connection

Clear session cookies on exit

("] Close error messages automatically

[ ]Swap mouse buttons

DPI aware

() Turn off UDP on Client

[ J1install missing fonts automatically

Raw printing support

(] Convert non distributable fonts data to images

Cache printers hardware information

The following advanced options are available:

Hide Launcher when application is launched. If this option is enabled, the launcher will be
minimized to the system tray after an application is launched.

Launch automatically at Windows startup. This option will place a shortcut in the start menu
folder of the client and the Parallels Client will launch automatically on Windows startup.

Note: If the Parallels Client shortcut was placed in the Startup folder during the installation (the option
was selected on the Shortcuts wizard page) for the current or all users, this option will not be shown as it
would have no effect. Same happens when this option is set via Client Policies by the administrator.

Allow RDP redirection of other supported RemoteFX USB devices to all users. The
RemoteFX USB redirection is a standard Windows feature that must be enabled in Windows
before it can be used in Parallels Client for Windows. When this option is selected, the
RemoteFX USB redirection feature is enabled in Windows. Note that Windows must be restarted
for the changes to take effect.

Show connection tree. Show published items as a tree.
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= On close, keep application running. After closing, keep Parallels Client running and available
from the system tray.

< Do not warn if server certificate is not verified. WWhen connected over SSL, and the certificate
is not verified, a warning message will be displayed. You can disable this warning message by
enabling this option.

< Add RAS Connection automatically when starting web or shortcuts items. This option will
add the connection preferences in the Parallels Client when starting an item contained in a
connection that is not yet listed.

= Don't show prompt message for auto add RAS Connections. Enable this option to disable
prompt messages when adding auto connections.

= Clear session cookies on exit. When a user logs on, a Parallels RAS logon cookie is kept on
the client side. This will allow the user to connect again with Parallels RAS without
re-authenticating. Check this option to delete any cookies when the user closes the Parallels
Client.

= Close error messages automatically. \When a session disconnects because of an error, the
error is automatically dismissed after 15 seconds.

= Swap Mouse Buttons. When enabling this setting, the mouse buttons will be swapped on the
remote computer.

= DPI aware. This will force a published application to be DPI-aware depending on the client's DPI
settings. This feature works on Windows 8.1 or higher.

= Always on Top. With this feature enabled, other applications will no longer mask the launcher.
= Turn off UDP on client. Turn off UDP for connections in Gateway mode.

= Show folders page. Enabling this option will show the available folders while showing the
hierarchy of the application groups as configured on the server.

= Minimize to tray on close or escape. Enable this feature to place the Parallels Client into the
System Tray when you click on the Close button or hit escape.

= Install missing fonts automatically. Install missing fonts.

= Raw printing support. \When enabling this setting, printing will still work for applications sending
data in RAW format.

= Convert non distributable fonts data to images. During RAS Universal Printing, if a document
includes non-distributable fonts, each page is converted to an image.

= Cache printers hardware information. Caching of printer hardware information locally to
speed-up RAS universal printer redirection.

= Refresh printer hardware information every 30 days. Same as above, but the cache is
refreshed every 30 days.

= Cache RAS Universal Printing embedded fonts. Caching of embedded fonts locally to
speed-up RAS universal printing process time.

Exporting and Importing Parallels Client Settings

You can export current Parallels Client settings to a file to have a backup or to transfer the settings
to Parallels Client installed on a different computer. The following settings are exported:
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= All existing connections including all individual connection properties.
= Parallels Client global options.

To export the current Parallels Client settings to a file:
1 Click main menu > Export Settings (File > Export Settings in classic interface).

2 In the dialog that opens, click the [...] button to specify a file name and a destination folder.

3 If you want to include credentials in the exported settings, select the Include access
credentials to the exported connections option. Please note that the resulting file will contain
sensitive information.

4 Click Save to export the settings. The file is saved with the ".2xc" extension.
To import settings from a file:

1 Click main menu > Import Settings (File > Import Settings in classic interface).

2 In the dialog that opens, select a ".2xc" file and click Open. Please note that the Parallels Client
settings stored in a file will override the current Parallels Client settings.

Parallels Client Command Line Parameters

Managing a single user session from the command line

The following Parallels Client for Windows parameters are available when launching published
application and published desktop in a single client session from the command line.

Parameters Note

sl="primary server' Primary Server hostname or IP address.
bl="backup server' Secondary Server hostname or IP address.
al="application/desktop id' Published Application/Desktop ID.

p!="'override application params'

tl="port’ Port of the Parallels RAS server connection.
ul="'username' Username for the user to connect with.
gl="password' Password for the user.

d!="domain' ignored if user name is in UPN format | Domain name.

['="0/1" O use primary server, 1 user backup server | Specify value in order to connect either to primary
or backup server.

ml="'connection mode' (gateway mode = 0, direct | Specify value for the connection mode.
mode 1, gateway ssl mode = 2, direct ssl = 3, direct

rdp=4)

o!l="0/1"if set to 1 credentials are overwritten with [ When set to 1, credentials are overwritten with
SSO information if available SSO credentials.

il="connection alias' Specify a connection Alias.

c! Always ask for credentials.

rl Reconnect if connection is dropped .
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Example:

1 In Command Prompt, go to the location were Parallels Client is installed and run the following

command:

TSClient.exe s!="2008adl.2x.testing"” al="#50" t!1="80" d!="2x.testing"

ul="testerjm=q!="123456" m!I="0"

Running the above command will launch Published application with ID92, for user testerjm.

Managing multiple sessions from the command line

The following Parallels Client for Windows parameters are available for managing several sessions

from the command line:

Parameters

Note

-s filename

Write session information to a file called "filename".

-importsettings filename

Import session setting from a file called "filename”.

-disconnectallsessions

Disconnects all RAS and RDP connections

-logoffallsessions

Logs off all RAS sessions and disconnects all RDP
sessions

-sharedevice "mode:args"
Possible modes are:

« 0: Delete any shared device information.
The existing shared connections will be
deleted by the client when it is started.

= 1: Create a shared connection and shared
connection information (i.e. server, port,
mode, backup connections, connection
mode)

e 2: Create a shared connection and shared
connection information (i.e. server, port,
mode, backup connections), and user
name and password. Connection mode is
assumed to be credentials.

Possible arguments are:

= ui: Show the Ul dialog to enter the shared
connection information and credentials.

= import: Import shared connection
information and credentials from a file.

= export: Export shared connection
information and credentials to a file.

Manage one shared connection for multiple users
working on the same Windows computer.

Possible combinations are:

- O

e T

« T:import:file
e 1:export:file
e 2

e 2:import:file
e 2:export:file

Usage

To call Parallels Client for Windows with these parameters, use the appserverclient.exe binary file.

For example, the command below will disconnect all running sessions:

appserverclient.exe -disconnectallsessions
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